METROPOLITAN STATE COLLEGE of DENVER

AN ADVENTURE OF THE AMERICAN MIND COLORADO

Helping Colorado Educators and Students Discover the Treasures of the Library of Congress

Geocaching,
. Google Earth,
LRS00 and Advanced
Integration

Prerequisite Tools and Skills

[] Personal Computer (Windows or Macintosh) with
Internet connectivity

[] Familiarity with Internet browsing and searching using
common wekbrowsers such as Microsoft Internet
Explorer or Netscape Navigator

[] Basic web browsing skills

[_] Ability to open and save files

[] Right and Left click functions on the mouse

[ ] URL (Uniform Resoure Locator) familiarity

[ ] Word processing software familiarity

[] Ability to upload and download email attachments as well
as files from the Web

[ ] Familiarity with digital video and audio formats

[] Ability to identify digital video, audio, and image
equipment

[] Video capabilitied recommended 256 MB RAM

[] Latest version of Apple QuickTime
http://www.apple.corguicktime/downloadbr Microsoft
Windows Media Player
http://www.microsoft.com/windows/windowsmedia/

[ ] Latest version of Adobe Reader
http://www.adobe.com/products/acrobat/readstep2.html
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Workshop 18: Geocaching, Google Earth, and Advanced Integration

Homework Activities

(Required for CEU and/or Graduate credit)
e None. This is the end of the line!

SaMIANOY
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Workshop 18: Geocaching, Google Earth, and Advanced Integration

Annotated Resource List

oo

Special Thanks to John Kuglin . Visit
his web site for tech nology and
Google Earth resources at:
http://lwww.kuglin.com

http://www.quasar.ualberta.ca/edpy202/tutorial/a
udio-win/audicwin.htm
http://www.indiana.edu/~emusic/digital _audio.ht
ml
http://www.microsoft.com/windosxp/using/mov
iemaker/expert/bridgman_02february18.mspx
http://www.digitaldiversity.com.au/whichvideol.
htm
http://arstechita.com/quides/tweaks/vidcap.ars
http://www.windowsmoviemakers.net/Tutorials/
HowToCaptureVideo.aspx

GPS Resources:
http://www.lane.k12.or.us/insttech/vtc/gps.html

http://www.gpsworld.com/gpsworld/

Google Earth:

http://earth.google.com/index.html

There are three versions:

Google Earth (free)

Google Earth Plus$20

Google Earth Pre $400

Check the Comparison Chart for details:

http://earth.google.com/product comparison.htmi

Goagle Earth Community:

Access activities, tours, tips, documentation, and
submit your own at:
http://bbs.keyhole.com/ubb/ubbthreads.php/Cat/0
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Workshop 18: Geocaching, Google Earth, and Advanced Integration

Class Preparation Checklist

Workshop 18: Geocaching, Google Earth, and
Advanced Integration

Required:

A4

Creativity!

A computer with an Apple or Windows
operating system and Google Earth installed.

Internet access.

At least one GPS for the class to use.

Workbook and notepad.

Optional:

A computer microphone (the $9.97 version is
just fine).

A Digital Still Camera or disposable camera.

A Digital Video Camera or another video
camera type.

A computer lab with Google Earth installed on
each machine.

More than one GPS unit.

Geocaching resources from An Adventure of
the American Mind Colorado.

A cassette or micrgassette recorder.

METROPOLITANSTATE COLLEGE OFDENVER
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Workshop 18: Geocaching, Google Earth, and Advanced Integration

A4

| Overview

Geocaching, Google Earth, and Advanced Integration

In Workshop 18 patrticipants will discover techniques of
capturing digital media on@mputer using the standard
features available on both PC and Mac computers. In
addition, participants will create new types of technology
adventures using geocaching and Google Earth with
Primary Sources participants.

Objectives

At the end of this worksip, participants will be able &

¢ |dentify the basic digital audio file types
available to use.

e Create audio files on a PC or Mac computer.

e Employ a sound booth made out of a box and
office/household items.

¢ |dentify the basic digital video file types
avdlable to use.

e Create and capture digital images with a
camera.

e Capture and edit video from a camcorder
using Windows Movie Maker or iMovie.

e Develop learning activities combining primary
sources with Google Earth.

e Utilize a GPS navigation system with prirga
sources for a field trip activity.

METROPOLITANSTATE COLLEGE OFDENVER
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Workshop 18: Geocaching, Google Earth, and Advanced Integration

LessonlA Capturing Digidea! Audio

Audio capture to a computer can be done in a variety of
ways that create different file types. It all depends on the
computer you are using and the applicationsyseito
capture the audio. In lesson 1, participants will start by
identifying the basic audio file types in use for media
production on a computer. Next, a few choices for
recording audio are introduced for both a PC and a Mac.
Finally, some audio recordytechniques are introduced
for better sound quality.

Activity1 -1 A Review of Digital Audio Types

Objective: Participants willi
e Identify the basic digital audio file types available to use.

1. The following chart explains the 3 basic audio file
types thaare created when you record directly into a
computer using a microphone.

File Type | Name Platform | Deployment File type is the file
Method extension found at the
aiff Audio Mac Steaming end of a file name
Interchange| Windows | Download (myvoice.aiffi for
File Format Record in a example).
Mac.
.wav Windows Windows | Download
Audio Record ina
Format PC.
.mp3 MPEG |, Windows | Streaming
level 3 Mac Download

METROPOLITANSTATE COLLEGE OFDENVER 3



Workshop 18: Geocaching, Google Earth, and Advanced Integration

Activity1 -2 A Recording Digit
Objective: Participants Wi 1

e Create audio files on a PC or Mac computer.
PC Only (recording wav files)
1. Make sure you are usingnaicrophoneghat is plugged
into the appropriate input on yosoundcard
In Windows, go to START>PROGRAMS>
ACCESSORIES>ENTERTAINMENT>SOUND
RECORDER.
At the bottom right of the sound recorder, press the
Recordand speak into the microphone at a distance of
about 6 inches.
When finished, clickStop(located next to Record).
SelectFile and selecBave

Choose a location for your sound file.

2.

o gk

For Mac Uses (recording aiff files)

INMACOSX, there is not an eq
Sound Recorder unfortunately. Audio recordings are done
through applicabns such as using the audio recording
features in PowerPoint:

. Insert>Movies and Sound>Sound Recorder
(records audio to a slide).

. Slide Show>Record Narration (records audio
to the entire presentation).

QuickTime PRO will also record audio, but costs $39.
and you end up with only a few extra feature than those
found in iMoviei which is free. The iMovie application
will record audio, but only as part of a video project.

METROPOLITANSTATE COLLEGE OFDENVER

NOTES:

al Audi o

Refer back to Workshop17

Make It and Take | 1tos
Activity 4-5 for diredions on

quick edits to wav files.

You will notice the green line

in the middle of the sound

recorder creating fAwa
the sound of your voice

ui valent to Micros


http://www.astro.uu.nl/~wiersma/dutchguy/archive/apple/recordingsoundsundermacos.html

Workshop 18: Geocaching, Google Earth, and Advanced Integration

NOTES:
Activityl -3 A Sound Booth in a Box

Objective: Participants willi

e Employ a sound booth made out di@ and
office/household items.

Do not rely on the buHin microphones on laptops or

desktop machines. A small investment under $10 will get

you a computer microphone that will produce much

better results. However, ambient noise (air conditioner, a

classnext door, or even computer noise) will also get

recorded if you are not careful. To remedy ambient noise

you can make your very own soundproof booth out of a

box and some additional materials. Hereds ho

1. Find a box. The most common in a school wilithe
kind reams of paper are delivered in; while an
appliance box from a TV or a computer can also work
just as well.

2. Next find soft, cushy, foamy, or otherwise
material: paper towel rolls (intattd on 6t wai st
paper!), recycled paper, $1 foam aces from a
hobby store, a pillow, or even a polar fleece jacket!

3. Line the box with youplushy finds!

4. Place your microphone in the middle of the open box
and speak into the microphone when ready and the
record button has been pressed!

Your creation shodl look something like this:

Yes, it looks goofy, but it
works well! You should
create a sound booth in a box
when your recordings are
generating unwanted noise to
go along with your rock star
voice!

METROPOLITANSTATE COLLEGE OFDENVER 5



Workshop 18: Geocaching, Google Earth, and Advanced Integration

NOTES:

Lesson 2 A Capturing Digital Images
and Digital Video

Image and video capture to a computer can be done
without a lot of fancy or extra equipment. Granted, you
get only basic capabilities from these resources, but
sometimes the basics are all you need to adielovio a

Power Poi

nt

presentation on

primary sources. Perhaps you want to add your own
video to a Microsoft Producer presentation using civil
war primary sources? Well, both Windows 2000+ and
Mac OS 9+ have the resources to creatéaligideo. In

the workshop we will focus on Windows XP and Mac OS

X.

Activity 2 -1

Video Types

A Review

Objective: Participants willi

of

Digital

Identify the basic digital video file types available to use.

1. The following chart explains therBost common

digital video file types that are used in multimedia

production:
File | Name Platform | Deployment
Type Method
.wmf | Windows Windows| Steaming
Media File Download
.avi | Audio/Video| Windows| Download
Interleave
.rm | Real Media | Windows| Streaming
Mac
.mov | QuickTime | Windows| Streaming
Mac Download
.mpg | MPEG Windows| Streaming
Mac Download
DVD

METROPOLITANSTATE COLLEGE OFDENVER
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Workshop 18: Geocaching, Google Earth, and Advanced Integration

Activity 2 -2 A Capturing Digital Images from NOTES:
a Camera

Objective: Participants willi

e Create and capture digital images with a camera.

1. BasicShooting Tips:
a. Center your subject

b. Get cl oseé too many objects in the bac
are distracting, unless they play a role in
the shot.

c. bon6t get too closeé your camera may
only focus up to a certain closeness.

d. Digital cameras are more sensitive to the
sunshindbehi nd your camer a
Youoll end up with a b
very dark shadow in the middle. You can
go into your camera settings to adjust for
this.

e. Do not use florescent light as a primary
light source.

f. Preselect your resolution for photos
used in a web site or PowerPoint, don't
bother with resolutions over 640 x 480 Note:an image resolution
pixels. You would simply be wasting the of 1600 x 1200 pixels can
storage space. take up to 1.5 MB each.

2. From the Camera to the Computer:

a. Digital camera (or camcorders) generally
use the USB interface to transfer digital
still images from a camera to computer.

b. When needed, use the software that came
with the camera. Especially for computers
with older operating systems.

c. For Windows XP or Mac OS X, most
cameras are automatically recognized
when plugged in via the USB poric
powered up.

d. If this is the case, you may have a choice
of applications to use. For PCs, several
options become available. For Macs,

Image Capture launches and recognizes
your camera. In both cases, you may
choose tdmportyour images and save
them to dolder in your computer files.

6s target shot
ri [ [
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Workshop 18: Geocaching, Google Earth, and Advanced Integration

1. Activity 2 -3 \Windows Movie Maker NOTES:
and iMovie

Objective: Participants willi

e Capture and edit video fromcamcorder using
Windows Movie Maker or iMovie.

Windows Movie Maker (Windows XP) What is Firewire?

1. New video camera models use #ieewire (IEEE
1394)interface to transfer video to a computer.
Connectyour cancorder to a PC using thkerewire
connections.

2. Switch your video ®layner ads power setting t
(VCR)mode.

3. Windows XP will automatically recognize most
cameras and launche®aital Video Device
window. This window offers any option on the
computer thais capable of capturing video.

4. SelectCapture Video usingVindows Movie Maker
and clickOK.

5. The application opens with\&deo Capture Wizard
were youselect your devicand clickNext

6. Enterafile namefor your captured vide@hoose a
location on youlPC to save the file, and cli¢kext

7. Select youwideo setting¢to learn more clickiideo
settingson the middleright of the window).

8. SelectCapture parts of the tape manuafthis allows
you to select what parts of the video you will capture)
and clickNext

9. TheCapture Videavindow appears with controls
(under preview window) for the camcorder. Try the
controls and queue up the video to where you want to
begin to capture.

10.When the tape is in queue clikart Capture

11.Click Stop Capturevhen finished.

12.The new video file is now available in th®llection
section of the application (middle of the window).
Select thecon of the video clipvith your mouse and
drag it to theTimelineat the bottom of the screen.

13.To capture more video, selécapture from ideo
device under Capture Video, on the left side of the
screen.

14.Refer to theedit Moviesection to add effects and
transitions between your video clips.

15.Finish Movieto save your final version with many
options to choose from.

METROPOLITANSTATE COLLEGE OFDENVER 8
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iMovie NOTES:
1. New video camera models use tisswire (IEEE
1394)interface to transfer video to a computer.
Connectyour camcorder to a Mac using theewire
connections.
2. Switch your video ®layner ads power setting t
(VCR)mode.
3. Select theMovie iconfrom the menu bar or go to
Applicationsvia Finderand selectMovie.
4. iMovie should automatically detect yocamera
showing a blue preview screen that reads,
Connected. 0 Notice the time |l ocation of th
the topright corner of the preview screen.
5. The VCR type controls under the preview screen
allow you to queue up your video to where you would
like to begin to capture.
Click Importto begin capturing video.
Click Importagain to end video capture.
Repeasteps 57 to capture more than one video clip.
Individual clips appear as an icon to the right of the
preview screen. Select timn of the videalip with
your mouse and drag it to th@neline
10. Add Transitionsbetween video clips by dragging a
selection between two clips.
11. Add Effectsto video clips by dragging a selection on
the video clip in th&imeline
12.Photos, images, audio and titles cam &le added to
theTimelineby selecting these items from a location
on the Mac.
13.When finished, seledtile from the top menu and
chooseShare
14.Shareyour movie via email, post to a web page,
record back to the video camera, create a DVD, or
save a QuickTira movie to your computer. You may
also share your movie by saving it to a Bluetooth
device such as a Palm Pilot.

© 0N

METROPOLITANSTATE COLLEGE OFDENVER 9


http://www.webopedia.com/TERM/I/IEEE_1394.html
http://www.webopedia.com/TERM/I/IEEE_1394.html
http://www.webopedia.com/TERM/I/IEEE_1394.html

Workshop 18: Geocaching, Google Earth, and Advanced Integration

Lesson 3 A Geocachi nN§g™and

Google Earth KMZ files are Google

Earth versins of Zip
Before you begin lesson 3, make sure you have Google files (if you will) and

Earth installed to your computer. Gnagain, the free will be discussed in
download is available &tttp://earth.google.corand is greater detail later in this
required if you would like to participate in activitie23 lesson.

to 3-10. In addition, you should have the Walking
Tour.KMZ file of downtown Denveready to access from
your course CEROM or USB drive; the file is located in
the folders Resources>GoogleEarth>DowntownDenver.
You may also download the KMZ file (and other Google
Earth goodies) at:
http://aamcolorado.mscd.edu/resources.htm

Satellite 101 GPSi Global

Positioning System
In order to fully understand how to use a GPS unit or

Google Earth it is best to have a basic understanding of

the satellite technology behind them. First, it is important

to understand thahé images in Google Earth are NOT iwWaypointso are th
live! In fact, images in Google Earth can be up to three GPS coordinates

years ol d. However, the 0 wgongudédnd &iudept a sent
unit is livel which may explain the confusion. There are  that display and

two types of satellites being used for Google Eanth a represent a location.
GPS:
GeoStationary satellitégavel at the same rate as the GISi Geographic

Earth spinning on its axi s |nrmiondystesot Happea
GPS units, GIS technology, and cable television use these

satellites to transfer data. In our case, the data sent to the
GPS are the wapoints.

Banding or norstationary satellites stay centered on the

poles and move as the Earth rotates on its axis. These

satellites scan the Earthds surface in a swa
gather images and data. These satellites provide a

majority of the images thabake up Google Earth.

Most of us think of the government and military

providing most of this imagery and data. Corporate 1 terabyte = 1 thousand
satellites provide a majority of the 1 terabyte of imagery  gigabytes

sent to Google Earth every week.

METROPOLITANSTATE COLLEGE OFDENVER 10
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NOTES:

Activity3-1 A Geocaching with Primary
Sources

Geocaching is a great field trip activity and can be
incorporated with Google Earth. GPS waypoints are
given in one of three formats:

1. Degrees, Minutes, Seconds (DMS)

2. Degrees, Minutes as decimal (DM.m)

3. Degrees as decimal (D.d)

Google Earth reads the DMS format like tt89:44.921'

N, 104 59.800' WA Garmin Rino 120 GPS unit will

display the same DMS format as:

N39° 44.921

W104° 59.800

Othea GPS or GIS systems my use the DM.m or D.d
formats. If this is the case, a conversion to the DMS

format is necessary to use GPS and Google Earth together, .
in the free version*Below is a resource that will qugle Earth Plus is
automatically convert these formats for you: available for $20 per

http://www.pdga.com/course/course _latlonhelp.ph year and includesa
p pdg B-php feature to import GPS

Objective: Participants willi data through a USB
connection.

e Create and/or utilize an activity using primary sources and a
GPS unit.

1. The first step is to find an Americandvhory
Collection that contains photographs of a specific
area. In this example, we found pictures of
Downtown Denver in the History of the American _
West 18661920 collection: Other Collections to
http:/memory.loc.gov/ammem/award97/codhtmli/haw  think aboutinclude:
phome.html

2. Search or Browsthe collection(s) for specific
locations that you can access with students using a
GPS*. Below is an photograph from our Downtown
Denver example:

1. Built in America

2. The Evolution of the
Conservation Movement
3. American

Oxford Hotel Environmental

Photographs
4. Civil War Maps

METROPOLITANSTATE COLLEGE OFDENVER 11
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NOTES:

3. Print imagesyou find from the collection(s) in full
page formatWrite down or printhe bibliographic
information of the photograph from the bibliographic
page as well.

4. Use the bibliographic information to either:

a. Map outyour route on a street map or trial
map (for National Parks) to guide you when
collecting waypoints in your GPS.

b. Enterthe locaton names in the Search feature
of Google Earth. If you choose this method
complete Activity 36 now and come back to
step # 5 below.

5. Createan activity for students to complete during
your tour. See the Historiclnvestigation.doc activity
included on youCD or USB drive in the Resources
folder. You may also download the activity at
http://aamcolorado.mscd.edu/resources. ithmer
activity ideas include:

a. Utilize a disposable or digital camera toeak
picture of the location now and create a now
and then book.

b. Analyzethe environmental impact of the
locationi issues and solutions?

c. Recreatdhe history between then and now.

6. Armed with the printed primary sources, activities
and a GPS unitdentifythe locations in which the
photographer had taken the primary source
photograph for each primary source. Keep a log after
marking the waypoints in the GPS* by writing them *Consult the manual of the

down as a backup. GPS unit you are using to set
7. Conduct your activity at each location or gather the ~ waypoints. The GPS used for
data necessgto complete the activity at school. this progct was garmin

8. Leave aGeocachdlinks to the Official Geocaching Féggnﬁ%?glg '(fhrgrgeh:g a2 o

Site)! Find a location to hide your activity for another  \yay radio included).
class of future students or leave a primary source of
your own. Caisult the web site for methods of doing
this and how to publicize your geocache on the site!
9. Return to the classroom to complete activities and
analysis after all of the locations have been visited
and logged with GPS waypoints.
10. Enter your GPS waypointsn(DMS format) into the
search feature Google Earth to create a tour (follow
the next activities to learn how to do this).

METROPOLITANSTATE COLLEGE OFDENVER 12
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NOTES:
Activity 3 -2  @oogle Earth Projects that
Integrate Primary Sources
Objective: Participantswill 7

e |dentify a Google Earth KMZ file as a potential project file
that can be created for or by students.

1. On your CD or USB drive, locate the You can organize your
DowntownDenver folder and the Walking saved data in a folder
Tour.kmz file inside. created in th&laces

2. Doubleclick the Walking Tour.kmz file. If pane in a way similao
GoogleEarth does not automatically start aftera ~ how you would organize
few moments Start the Google Earth program. files and folders on your

On the Main Menu, sel ecetompuersbarddriveépen VY

the file on your comput &hisisihgwthe Wakingp e n

select Walking Tour . kmz TourKYZfilegvrs Open .
3.Scroll down teéer®ed |lparne itncreatthe APl ac

Walking Tour.kmz file.

(1

Wi n

4. Click the carrot (arr owKMZfiesateatyre ofi wal ki ng
Tour.kmzo file to expandipfiefhatopensgpa of dat a
in the file. project or folder in the

5. Continue to scroll the datathe yellow Places pane. The file (or

thumbtacks are call ed fipomaressedfaldeR so and
others are .id maagwe wivlelr | laeptginsall ofithe data

to create these in the next few lessons. and media used to create
6. Doubleclick on one of the placemarks on the the project in Google
screen to zoom in and visit a location. Earth. By the final

activity in this lesson
you will be able to save
a project as a KMZ file.

Google

Web inagss Groups Mews Froogle Local Scholar morew
aduanoad Suh

Google Search Im Feeling Lucky | Lasauage Tools

METROPOLITANSTATE COLLEGE OFDENVER 13



Workshop 18: Geocaching, Google Earth, and Advanced Integration

NOTES:
Activity 3 -3 Mavigating Google Earth

Objective: Participants willi
e Utilize the interface cdmols of Google Earth for optimum
use.

You can navigate through Google Earth in three ways:
e Using a mouse
» Using the navigation controls
« Using thekeyboard controls

For this activity, the focus is on the use of the nalwgat
controls, the Layers panel, and the Places panel.
However, you may click on the links above to learn the
other methods of navigation.

From Left to Right:

1. TheZoom Slideccan quickly zoom in or out of
the view. Use the plus button to zoom in slightly
ard stop. Use the minus button to zoom out
slightly and stop.

2. Rotate from the top of the screen, or true north,
left or right (opposite side of arrow control pad)
by clicking on theRotate Buttons

3. ThedorthUpd button resets the top of screen
view to truenorth after the view has been rotated
around.

4. TheArrow Control Padmoves the 3D view in the
desired direction. The center red dot is used like a

Ajoysticko to move instantly in any direc
5. Th RestTid wi | | reset the tilt view |l ooking
directtydownor fAt op downo after adjusting the

tilt using the next navigation feature.
6. TheTilt Sliderwill tilt the terrain toward a
horizon vi ew. Push up for a ATop Downo vi
and down for a horizon view.
7. On the far right, thé&lacemark Buttoms used to
quickly addplacemarks, image overlays, and
other data. Additionally, the current screen can be
printed with thePrint Buttonor emailed with the
Email Button

©® 66
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NOTES:

8. Thelayersfeature in Google Earth provides a
variety of data points of geographic interémstt
you can select to display over your viewing area.
This includes points of interest (POIs) as well as
map, road, terrain, and even building data. The
most commonly used layers are available on the
Navigationpane, and the full list of layers is
available in theLayerspane.Select or Checthe
boxes to activate a layddncheckhe boxes to
de-activate layers or hide them.

You can turn off the
display of common
layers in theGoogle
Earth Ogionswindow
(Tools- Options-
Preferencep You can
also collapse theayers
pane by clicking on the
white triangle to the left

[ e Lodging I~ ¥ Dining of theLayerslabel.
™ @ Roads ™ [ Borders The commercial use of
: = Layers is how Google
il T I {3y Builch )
3 Terrain i makes money with
Common Layers on Navigation Pane Google Earth. This
application was
E—— originally developed as

v [J & Layers
»[] B terrain
)D £ Hational Geographic Magazine
)D (] Google Earth Community
)D [~ Community Showcase
D i Google Earth Community (Unrankt_‘i'
) == Populated Places
)D £ atternative Place Hames
)D E borders
»[] E2 pining
[] k= Lodging
[] ) BanksiaTMs
[] <7 BarsiClubs
D To Coffee Shops
D @ Shopping Malls
] @ Major Retail
[] B MoviemvD Rentals
[] & Grocery Stores
|:| B pharmacy
D [ Gas stations
£ Goir i

Layers Pane

a marketing tool that
would compete with
Mapquest.
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NOTES:
Activity 3 -4 A Cr &aoglé Eagh
Projects that Integrate Primary Sources

Objective: Participants willi

e Develop the components of a Google Earth project using
primary sources and sag it as a KMZ file.

1. Scrollthrough the Places Pane, extend folders,
and check (to view) or uncheck (to hide) data. For
the remaining activities you will need the Walking
Tour.kmz file checked.

The Walking Tour folder contains placemarks and
image overlgs created for this Google Earth and
primary source project. Steps Z of this activity
takes a stepy-step look at how to create projects
like the Walking Tour.

In Activity 3-1, the

Walking Tour ki fle
opened automatidglin

v [V]S MyPlaces
» V5D sightseeing the Temporary Places
Start your Google Earth world tour here! folder. Anyth i ng located
Sko anundarined in Temporary Places
Google Earth default view. L WI” be deleted When
= Edit/Snapshot & new view to change your GOOgle Earth is closed.
w [V]<3 Temporary Places -
« 71 Viaiking Tour ks Folders and kmz files
+ V] Walking Tour can be moved to My
[V]€2 Google Earth - Hew Image Ove Places for permanent
o storage.
Mattie Silks

@) Mattie Silks' House of Mirrors
Mattie Silks' House of Mirrors
[IMG]http: iphotoswest .org/photosi 0

@) Equitable Building - 17th & Sto
Equitable Building - 17th & Stout

Q Equitable Building - 17th & stoﬁ

C W (@)
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2. Createa new folder in the Places Plane by either
Selecting-olderfrom the Add Menu ORClicking
the Pushpin icon on the navigation panel and
Selecting~older from the pojup menu. The New
Folder dialog appears:

a.

Name i Enter the name of your

project.

Create in

Folders can be added to My Places,

in existing folders or Temp orary
Places. If you created a new

folder by right - clicking on an
existing folder in your Places

listing, that folder is already
selected as the container for your
new folder; however, you can
always select another folder

simply by clicking on one. If you
select Temporary Places as the
location for your new folder, it

will not automatically be saved

for the next Google Earth session.
Before exiting Google Earth, you
are prompted to save items in the
Temporary Places folder. If you

select Yes atthe prompt, the
items are moved to your My Places
folder. Otherwise, the folder

will be deleted when you close
Google Earth.

Additional subfolders

You can create additional folders

by first selecting a parent folder

in the list and then by clicking

the New Folder but ton to name the
new folder. Repeat this step for

each additional folder you want to

add.

Descriptive text

Enter a description for the
folder. For example, you might
enter text that gives a general
description of all the placemarks

in the folder. The first few words
of the description appear below
the folder in the Places pane.

When you double - click the folder,
the description appears in a
balloon in the 3D viewer.

Camera angle/View

Select the Advanced check box to
set a viewing angle that applies

to the fo Ider Once you set a view
for a folder, double - clicking on

METROPOLITANSTATE COLLEGE OFDENVER

the
folder
reposit
ions
the 3D
viewer
to that
positio
n you
have
chosen.
Setting
aview
fora
folder
is
useful
when
you
want to
create
a
viewing
angle
to
encompa
ss all
the
items
contain
ed by
the
folde .

Style
Once
you
have
other
icons
within
the new
folder
(orits
subfold
ers)

the
Style
menu is
availab
le. You
can use
this
feature
to
apply
label
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and icon styles universally across
all items within the folder.

METROPOLITANSTATE COLLEGE OFDENVER

NOTES:

Click OK when
complete!
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NOTES:

3. AddaPlacemark in the Places Plane by either
SelectingPlacemark from the Add Menu OR
Clicking the Pushpin icon on the navigation panel
andSelectingPlacemark from the pepp menu.
The New Placemark dialog appears:

a. First, Position the placemark.

To do this, psition the cursor on the
placemark until the cursor changes to a
pointing finger and drag it to the desired
location. The cursor changes to a finger
pointing icon to indicate that you can
move the placemark.

.
ew Placemar

1&
F o _

You can alsdock the placemark position
or set advanced coordinates far i
position.

b. Namethe placemark

c. Choose an Icorto represent the
placemark (other than the pushpin)

d. Select a destinaticiolder to hold the
placemark or create a new one.

e. Add a Description, including HTML text

Click the OK button to apply the

informatio n you entered in the

placemark dialog.

4. Createan Image Overlain the Places Plarigy
eitherSelectingmage Overlay from the Add
Menu ORClicking the Pushpin icon on the
navigation panel an8electingmage Overlay
from the popup menu. The New Image OvVay
dialog appears:

.

Image overlays can be
JPG, BMP, TIFF, TGA,
or PNA format. When
using images from
American Memory, the
JPG format is
recommended.
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http://www.keyhole.com/GoogleEarthHelp/Places/Repositioning_Placemarks.htm#Lock

Workshop 18: Geocaching, Google Earth, and Advanced Integration

NOTES:

a. Provide a descriptive name in theName
field.

b. Type the locatian of the image fileyou
want to use as an overlay or use the
Browsebutton to locate it on your
computer or network. URLs can be used
and retrived by rightlicking
[Contol+click on a Mac] on the image on
its web page and selecti@ppy Image
Locationfrom the popup menu.At that
point, you can insert your cursor in the
Image URL or Filenaméeld and paste
the information using Ctrl+V.

c. Indicate the folder where you want to
place the overlay.

d. Specify the descriptive information for
the overlay. Descriptios for overlays are
identical to descriptions for all places data. _

e. Set the correct refresh propertiesor We focus on image
your fAtime basedo ov@VPﬂa)@Y"'thPWWé’ger y .

sources. Howevel,ou

Typically, any imagery that is updated can also use
automatically and located on a server will ~ topographical maps,
need refresh properties sétor example, weather satellite image
weather satellite image maps will likely maps, or other
need to be refreshedror details on the geographical image data
differences between tirdeased and view as overlays. For ideas
based refresh, see thescription for and examples of
network links overlays, see the

f. Set the default transparencyfor the Keyhole Community
imagery using the slider. bulletin board

g. Position the Overlayby using the green (bbs.keyhole.coin

markers to size and move the image.
i. Use the Triangle Marker to rotate
the image for better placement.

ii. Use thecenter crosair to move
the image in the right position.

iii. Use any corner to stretch or skew
the size of the image. HOLD the
shift key down to hold the image to
scale when adjusting the size.
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http://www.keyhole.com/GoogleEarthHelp/Places/Creating_a_Network_Link.htm#refreshRate
http://www.keyhole.com/GoogleEarthHelp/Places/Creating_a_Network_Link.htm#refreshRate
http://www.keyhole.com/GoogleEarthHelp/Places/Creating_a_Network_Link.htm#refreshRate
http://bbs.keyhole.com/
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5. Editing Placemarks and Image Overlays by NOTES:
selectingthe item in the Places Pamight-
clicking [Control+click on a Mac], andhoosing
Edit. The Edit Placemark or Edit Image Overlay
window appears and has the same fields as the
original dialog windows.
6. Addprimary sources to Placemark or Image
Overlay Description fields using HTML. Direct
links to images, audio and video can be added to
the description fields.

Create a new or edit and existing Placemark or Image
Overlay and attentghe following examples:

a.

Image Example- Go to the following

Panorama of Denveright-click

[Contol+click on a Macbn the image on

its web page and seleCbpy Image

Locationfrom the popup menu. Use the

<img src="..."> tag and paste the Image

Location between the quotes:

<img

s r chttpd/memory.loc.gov/pnp/pan/6a
02000/6a02700/6a02729r.jjug >

Audio T Go to the following page of

Edi sonds Address ,to the American
right-click [Contol+click on a Mac] on the

icon for the WAV file (or Mp3) and select

Copy Link Locatiorfrom the popup

menulUsethe<a href =0é0>Edi son
Address</a>tags and paste the Link

Location between the quotes:

<a

href=0http:// mefedbssty. | oc. gov/ mbrs
50509r . wavo>Edi son Address</ a>
VideoT Go to the following page of an

Annie Oakley videpright-click

[Contol+click on aMac] on the icon for

the MPEG (or QuickTime) and select

Copy Link Locatiorirom the popup

menu.Usetheca hr ef =0é0>Anni e
Oakley</a>tags and paste the Link

Location between the quotes:

<a href=0
http://memory.loc.gov/mbrs/edmp/4030.
mpgo>Anni e Oakl ey</ a>
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http://lcweb2.loc.gov/cgi-bin/query/i?ammem/pan:@field(NUMBER+@band(pan+6a02729)):displayType=1:m856sd=pan:m856sf=6a02729
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7. Savea project folder with placemarks, image
overlays, and other data as a KMZ file to archive
or email to other Google Earth users, such as
students or teachers.

a. Selecthe project folder you would like to
save in the Places Plane.

b. Rightclick [Control+Click on a Mac] on
your selection and chooSave Asrom
the dropdown box.

c. Inthe Save file windowSave A§ name
your file if different from the folder name.
Wherei select a destinatioformati
select KMZ (a zip file with media) or
KML (text and data only).

METROPOLITANSTATE COLLEGE OFDENVER
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Activity 3 -5 Searching and Creating Primary
Source Tours in Google Earth

Objective: Participants willi

e Ultilize the search features in Google Earth for GPS
activities and locating points of origin.

1. Searchfor specific locationsising theFly Totab.

a. City, State = Denver, Colorado

b. City, Country = Panama City, Panama

c. Number Street, City, State = 1600
Pennsylvania Av. Washington DC

d. Zipcode or Postal Code = 20002

e. Cross Street, City, State £ &nd Market,
San Francisco, CA

f. Longitude, Latitude in decimal format =
37.7,-122.2

g. Longitude, Latitude in DMS format 39
44.921'N, 104 59.800' W

Local Search  Directions

|| B

2. Thelocal Search Talwill locate directory

' istings by Exact Names

NOTES:

Commas are not
required when entering a
location.

Street address searches
are currently (2006)
only available in the
USA and Canada.

(ALi brary of Cong

Parti al Names (ASmithsoniano results in s
l' istings with ASmithsoniano), or Keyword
(Acoll egesd). This is how Google makes mo

off of Google Eartii marketing.Typei n fApi zz ao

for a listing of all the pizza restaurants in the area.

I Current view L] @
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3. In theDirections Tabyou maymanually enter NOTES:
locations in the same formats used in the Fly To
Tab to the Start and End fields.

FlyTo  Local Search  [Directions

However, there are two additional ygathe Start and
End fields in the Directions Tab are populated:

a. RightClick on an icon or listing result and
selecteitherDirections from thiOR
Directions to this

b. Click on theTo Hereto automatically add
an End point oFrom Hereto
automatically ad a Start point in the
Directions Tab. These links are located in
the placemark information balloons that
contain the description information viewed
in each placemark.

Click on the APl ayo button to take a Flyov
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